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AutoCAD® Secrets Exposed

Jeanne Aarhus - DiversiCAD

GD31-1 This session is filled with time-saving tips and tricks that can be used to increase your productivity
immediately. Some of AutoCAD's most precious features - and time-savers - are either buried in the
documentation or have been lost in the upgrade shuffle. Attend this session if you are too busy
"working" to spend time digging through all the new and old documentation and online information. Do
you take advantage of new tools available or are you still doing things just like you did years ago?
Some of the best and most productivity-enhancing tools have been introduced in recent upgrades. To
take advantage of them, attend this session and discover what might take you years to discover on
our own.

About the Speaker:

Jeanne is known for keeping her training sessions fast moving and fun. She is a nationally known
speaker and expert in CAD and presents seminars and workshops on CAD productivity for managers
and users in both corporate and college settings. She has been involved with production drawing,
user support, standards coordination, programming, and training in CAD applications for more than
20+ years. She continues to be actively involved in international, national, and local CAD user groups.

jaarhus@cox.net






AutoCAD® Secrets Exposed!

AutoCAD® Secrets Exposed

The topics | selected for this presentation were collected from friends, co-workers, other user
groups; and of course the newsgroups.

If you have an idea or a great tip to pass along.

About this document:

=N
' Secret available in AutoCAD 2002

[ oyl |
S
c-l Secret available in AutoCAD 2004

=
H' Secret available in AutoCAD 2005

AL

Bl Secret available in AutoCAD 2006

I invite you to share your ideas with other users.
This only works when we ALL share ideas and concepts. Keep the information flowing....and thanks
to all those who helped with this collection of ideas.

I will assume that most of you are in 2002+ versions, at least | hope so!

Secret to Expose!

N =
alell

[

Thanks to everyone who contributed ideas to this session. And remember me if you have a clever
way to use AutoCAD, send me YOUR *“secrets”. We all learn through sharing!
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1 Rotating the WORLD il i Bl = r‘.

No, you can’t control how the world spins; but you can control how it rotates! Do you ever need to
draw at an angle for an extended period of time? Maybe that road or floor plan isn’t at zero?

Rotate the CURSOR

Step 1: Use the UCS by OBJECT command

Step 2: Select an object in the drawing that you
need to align with.

uCSs
12 tg e bl Bie e 18

Your cursor is now aligned with that object.

Note: If you use POLAR SNAP settings you can still have other angles at your disposal.

Step 3: Use the UCS by WORLD command to ucs
return the cursor to the WORLD rEeklekrre L2 Rige 3
alignment.

You can void getting that “crick” in your neck by adding in this idea. Modify the system variable
UCSFOLLOW so that your screen follows the cursor, rather than the other way around.

Rotate the SCREEN
Step 1: Key in UCSFOLLOW and change the value to 1
Step 2: Use the UCS by OBJECT command -
ucs

Step 3: Select an object in the drawing that you R I=AR AR LB =R R R R B A L R
need to align with.

Your screen is now aligned with that object.

Use the UCS by WORLD command to

return the screen to the WORLD Ues
alignment. rewleEre Ly tie e E

Note: You should also notice that the UCSICON appears differently when you are not

aligned to the “world” alignment.
Y v
;—D X g—D X

WORLD OBJECT
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2 Windows-Like MOVE and COPY il L2 i = h.

If you're used to using the drag-n-drop technique in Windows, then you need to know you can do
this in AutoCAD too! You can’t use exact precision with this, but it is helpful when you are just
trying to move an annotation symbol or text object out of the way.

To MOVE the object:

Step 1: Select an object, you should see grips.

Step 2: With the <Left-Click>= on your mouse, select the object (NOT on a grip) and drag it to
the new location.

You should see the standard windows “move” icon on your cursor.

To COPY the object:

Step 1: Select an object, you should see grips.

Step 2: With the <Left-Click> on your mouse, select the object (NOT on a grip) and drag it to
the new location while holding down the <CTRL> key.

3

. . '
You should see the standard windows “copy” icon on your cursor.

\
3 More Windows-Like COPY &H!

To COPY with Precision

Step 1: Select an object(s) and pick the GRIP for the location point to copy from.

Step 2: Drag the object(s) to a “snappable” location and hold down the CTRL key when you
select the “snappable” destination.

Easy right? Hopefully someone out there can use this!
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4 Multi-Leader Arrows =il =1 2l

This is another use for the previous functionality. If you use the CTRL key to COPY existing objects
in your drawing, you should also know that you can use this same technology on a dimension
leaders for notes.

ADD More Leaders

Step 1: Select the Dimension Leader and select the grip at the “arrow” end of the line.
Step 2: Hold down the SHIFT+CTRL keys and select a new “arrow” destination in the drawing.

Step 3: You can continue to add additional leader arrows as needed while holding down the
SHIFT+CTRL keys.

\
5 New Multi-Leader Arrows &“!

This is another use for the previous functionality. If you use the CTRL key to COPY existing objects
in your drawing, you should also know that you can use this same technology on a dimension
leaders for notes.

ADD More Leaders

Step 1: Select the Dimension Leader and select the grip at the “arrow” end of the line.
Step 2: Position your cursor at the new “arrow” destination in the drawing.

Step 3: Press and hold the CTRL key when you click the new destination location.

You do not need to continue to hold down the CTRL key for additional leaders, you are
in a “copy” mode now.
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6

Useful Hyperlinks

AutoCAD® Secrets Exposed

Zlale )

/A

Everyone uses hyperlinks to navigate to a specific web site, but have you thought of other ways
you could use this tool? How about a hyperlink to navigate to a reference file? Or a hyperlink to

navigate to a product specification? Check it out!

Hyperlink to a Reference File:

Step 1: Select the command Insert > Hyperlink and select the reference file

Step 2: Pick the File button and navigate to the file location of the reference file.

Now use this hyperlink to open the reference file for editing. A great shortcut!

Step 1: HOVER over the reference file and you should see the “hyperlink” icon. e

The tool tip will remind you to hold down the <CTRL> key when selecting the file to

follow the link to the reference file.

il

(11| [T

X:\ACAD_Secrets_Exposed\dwg\8th floor plan.dwg
CTRL + click to follow link

A

Hyperlink to a View:

Step 1: Zoom in on the revised area.

Step 2: Select View > Named Views and
pick the NEW button to save the

current view as REV2.

| placed the Revision Notes themselves in
PaperSpace, so | will place the actual
hyperlink there.

I — N TN

I Insert Hyperlink

Lirk ko:

Text to display: |Revz

Select a view of this

= #ACAD_Secretsidwaglgth floor,dwg
[=- Model

8th Floor Furniture Plan
8th Floor HYAC Plan
ath Floor Lighting Plan
8th Floor Flan

8th Floor Plumbing Plan
8th Floor Power Plan

¢ ]

@3]

Cancel ] [ Help

Step 3: Select the layout and zoom
window around the revision notes @
area of the sheet.
Step 4: Select the Revision 2 objects
3 objects selected.
Step 5: Select Insert > Hyperlink and 0 abjects with hyperiinks.
choose the Link to = View of this
Drawing
Step 6: Expand the model file and select the named view Rev2

Test the hyperlink from the sheet to verify that it is working.

AUTODESK
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7 Copy Objects from the XREF “jajefs

Have you ever wanted to copy an object or several objects from a reference file?

Hopefully, you are already familiar with the single object method. To copy a single object you use
the Express Tool COPY NESTED OBJECTS.

Copy SINGLE Object from XREF:

Step 1:
Step 2:

Select Express > Copy Nested Objects

Select the object in the reference file and copy it to a new location.

The next option is a little more difficult, but well worth the effort!

Copy MULTIPLE Objects from XREF:

Step 1:
Step 2:
Step 3:

Step 4:
Step 5:
Step 6:

Step 7:

Select the XREF you need to copy from
<Right-Click> and select the command EDIT XREF IN PLACE

Choose the level of editing you need, file, block, etc. and highlight the appropriate
level.

Select the objects you want to copy and copy them to the new location.
Select the new copy of the objects.

Pick the REMOVE FROM SELECTION SET button Refedit
on the Refedit toolbar. A [t fioor funiture W o B g

This will remove the newly copied objects from the xref file set.

SAVE your changes from the Refedit toolbar.

You are now back in the original drawing and the objects you copied are in this file not the Xref file.
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8 How to get GREAT IMAGES from AutoCAD = =l &n!

I constantly get this question from users.

“How can | get good images of my drawing files into a PowerPoint presentation?”

First, | recommend using the Windows clipboard, and since AutoCAD 2005, the background is
automatically clear!

Paste Image into PowerPoint

Step 1:

Step 2:

Step 3:

Step 4:

H F
Setup the AutoCAD view window with the i |deaS Rea | |Zed
desired layers and aspect ratio. g
AU

Select everything using a window or
crossing.

Autodesk

Copy the selection set to the windows
clipboard.

The only thing you will see if it is
successful is a “quick flash” in the drawing
window.

Paste the clipboard image into any
PowerPoint presentation.

Note: The background of the image is automatically clear in AutoCAD 2005 and
2006!

Note:  For previous releases you will need to modify the drawing background to
white for good image capture.
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Control Startup Workspace jtoworld.com fasth |

If you are using the new workspaces in AutoCAD 2006, you probably have wanted to control which
workspace is set on startup. Here is a great tip that will set the workspace on startup.

Automatic Workspace Setup
Step 1: Create a script file with the following contents
(if (/=(getvar "wscurrent') "WSname') (command "‘wscurrent' "WSname'))
Step 2: Be sure this script file is in a defined support directory.
Step 3: Edit the startup icon and add the following startup switch.

C:\...\AutoCAD 2006\acad.exe /b ""StartupWS.scr"

Step 4: You can also set the default profile on startup using the following startup switch.

C:\...\AutoCAD 2006\acad.exe /p ProfileName /b "StartupWS.scr"

Note: Once this script is created you can use it to set other defaults on startup.

=N =0
10 Maximize Dialog Columns el = L3 =t ﬂl

You can <Right-Click> on any column heading in a dialog to maximize the column width.

[Bf] Layer. Properties Manager,

i
E% B #. % o Curent layer: 0 }
= =% Al Stal On | Fre | Loc| Color Linetype Linewginkt Plat Crl | Plat N sc:»;
< Al Used Lapers Y g O mnm Maximize all columns _
< U O % Wuhie CONOUS — [ NMaxjmize column J
. Y O M @eyan CON.OUS — L - H
~ . ) O T3 W mts CON.OUS —— Default Normal 2 L
<. U Q@8 CON.OUS — Default Normal & i
. ) O 73 @&  CON.OUS —— Default Normal o i
- ! (3 Ty W mia CON.OUS —— Default Normal 2
b B il :.__p,‘ P I _‘\.'*x.\_.-_-._,._\__\_.-..-ﬁ—-__‘\_..\‘;

[Bf] Linetype Manager

Linetype filkers . E Delet
| Show all linetypes R | [ Irwert filker
Current Show del

Current Linetype: Byl ayer

Linetype Appearance
o o Maximize column headings ;
Bl ayer ———
ByBlock
ARENIER. | | posrmesti | | et o s bt s b -
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1 1 Easy Super/Sub-Script Text jafert: h.

You can use the stacked fractions to get quick and easy superscript or subscript text without the
dialog box.

SuperScript Text

Step 1: Key in 2 32 and highlight the 327~

| . Superscript 22
Step 2: Select the Stacked Fraction button F

Subscript Text

Step 1: Key in 2 ~a and highlight the ~a

Subscript 22

1=
Step 2: Select the Stacked Fraction button

More Examples

Key in TOP/BOTTOM and highlight the entire string STACK TIP - BOTTC%%M
Key in TOP#BOTTOM and highlight the entire string STACK TIP - TOE’EOTTOM
Key in TOPABOTTOM and highlight the entire strin
Y o 9 STACKTIP-1%,,

Key in TOPABOTTOM and highlight the ~“BOTTOM STACK TIP - TOPgo 1o

Key in TOPBOTTOM” and highlight the BOTTOM™ STACK TIP - TOPBOTTOM
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12 Stack Those Dimensions il [;l L3 =t ﬂl

Now that you know everything you need to stack anything, how about in dimensions?
Unfortunately, the previous options don’t work the same when you are working with dimension
text. But try this little trick, it works great!

Two lines of Dimension Text

3.0863
Step 1: Edit the dimension text using the MText editor. | TYP. |
Step 2: Press the ENTER key after the “dim value” in the ‘ ‘
editor and add TYP. on the second line.
You should notice that the output wasn’t quite | |
what you were expecting.
Step 3: Edit the dimension text again, and change it to | 3.0863 |

“dim value” \XTYP. |ﬁ TYP. -

Isn’t that what you really wanted? | ‘

= =
13 Multiple DTEXT Objects Autodesk =i =1 S = FAI

In 2006, the DTEXT has changes slightly in functionality. In prior versions, you could continue
placing additional DTEXT objects without re-starting the command by picking a blank location in
the drawing. In 2006, this option disappeared, but you can get it back by setting the following
system variable.

AutoCAD 2002, 2004, 2005

Step 1: Key in the DTEXT command and enter the needed text
Step 2: Pick in a blank location in the drawing to start a new DTEXT object.

Step 3: Continue to place as many DTEXT objects as needed without having to re-start the
DTEXT command.

AutoCAD 2006
Step 1: Modify the system variable DTEXTED to 1 to allow multiple insert points for DTEXT.
Step 2: Key in the DTEXT command and enter the needed text
Step 3: Pick in a blank location in the drawing to start a new DTEXT object.

Step 4: Continue to place as many DTEXT objects as needed without having to re-start the
DTEXT command.

AUTODESK
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14 CLEAN Image Frames on Paper el i B = h.

When you use logos or images in your title blocks or drawings you need the image frame to be
visible to allow you to manipulate the image. But you don’'t want the image frame to plot right?

Try using the IMAGEFRAME command to get the exact control you need.

IMAGEFRAME | controls whether image frames are displayed and plotted

0 - Image frames are not displayed and not plotted.
1 - Image frames are both displayed and plotted.
2 - Image frames are displayed but not plotted.

Image OFF for Plots Only

Step 1: Key in IMAGEFRAME and set it to 2. This allows you to manipulate the image but it
won'’t plot.

Y |deas Realized

Autodesk

Autodesk

hus hus

ASSOCIATES ASSOCIATES
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15 Using BYBLOCK Autodesk Zlafe

There are two generic options for layer color, weight and linetype in AutoCAD, they are BYLAYER
and BYBLOCK. Everyone knows and uses the BYLAYER property setting, but | am always amazed
how many users don’t use or don’t understand the BYBLOCK property setting.

BYBLOCK Definition

Inherit individual properties first, use layer properties second.

BYBLOCK Example

This example will show you how you can use the BYBLOCK property definition to create “generic”
blocks that can be used for more than one representation.

This one DOOR block can be used for Existing, New and Demolition block symbology.

Step 1: Create DOOR block using BYBLOCK for color, linetype, and lineweight on the Door
Panel object, and BYLAYER for color, linetype, and lineweight on the Door Swing
object.

Step 2: Place the DOOR block on the following layers, A-Door, A-Door-Demo, A-Door-Exst.
Step 3: Select the NEW door block and change the CURRENT WEIGHT to .50
Step 4: Select the DEMOLITION door block and change the CURRENT LINETYPE to

CONTINUOUS.
BYLAYER
"h
= \
@ \
i
[
Original Demolition Existing
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Controlling the New MTEXT Autodesk ]

One of the best reasons for using MTEXT is the ability to manually adjust the text width of the
paragraph by dragging a grip and resizing or stretching the paragraph width. This has changed
slightly in 2006 if the text is CENTER justified. Stretching CENTER justified MTEXT in 2006 also
moves the center origin of the entire MTEXT object.

To re-size MTEXT in 2006, AutoCAD expects the user to use the Ruler in the In-Place Text Editor,
not by grips. Sorry, but | agree, this is too many steps!

To revert the MTEXT grip editing functionality back to the “old way” you need to change the system
variable CENTERMT.

CENTERMT controls how grips stretch MTEXT that has a centered justification.
The default setting is 0.

0 - When stretching the MTEXT with grips, the center grips also moves in the same

direction.
1 - When stretching the MTEXT with grips, the center grip stays in place while the text is re-

sized.

THIS IS CENTER JUSTIFIED THIS IS CENTER JUSTIFIED

MTEXT MTEXT
THISIS THIS IS CENTER
CENTER JUSTIFIED MTEXT
JUSTIFIED
MTEXT

AUTODESK
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\
17 Prefer the “OLD” MTEXT Editor? Autodesk &“!

To get the old MTEXT editor in AutoCAD 2006 modify the following system variables.

MTEXTED sets the name of the application to use for editing multi-line text objects.
internal -
oldeditor —

MTEXTFIXED displays the Multi-line Text Editor at a fixed position and size based on last use, and
displays text in the editor at a fixed height. This setting is obsolete if using the new MTEXT Editor
in 2006.

it e
. 8] 'k ~oa Nawon Sjeaw MBI oUW LI IRC T S - Standard | B vial Nanow voam v|g 7 U w v oK
EFA (FEE iSi=ic @ w85 @ o0 3 sefo 3 ofton |2

OLD MTEXT Ediitor

MTEXT Editor in 2006

\
18 ZOOM Transitioning Autodesk &“!

The new ZOOM commands have smoother view transitioning than previous releases of AutoCAD. If
you think that this smooth transitioning is “cool” but too slow for your daily use, you can restore
the “old” transitioning using the system variable VTENABLE.

VTENABLE controls when smooth view transitions are used. Smooth view transitions can be on or
off for panning and zooming, for changes of view angle, or for scripts. The following options are
available

Setting Pan/Zoom Rotation Scripts
0 Off Off Off
1 On Off Off
2 Off On Off
3 On On Off
4 Off Off On
5 On Off On
6 Off On On
7 On On Oon

AUTODESK
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19 Controlling Hatch Origin KEil El L& =t r‘.

You can modify the origin of a hatch easily in 2006. There is a new specify Hatch Origin option in
the Hatch Edit dialog.

AutoCAD 2006

Step 1: <Double-Click> on the existing hatch to Hatch arigin

edit the hatch. ) Use cument origin

a1 Coacifiad oriois
- =

Step 2: Select the Click to set new origin
button and pick the origin point in Click tor g2t nesw origin
the drawing.

—
LI Lreralit o Dolrndarl) ealent

Step 3: Pick OK to complete the command.
[ Stare as default origin

AutoCAD 2002, 2004, 2005

In the previous releases, you cannot modify the hatch origin of existing hatches, but you can set
the hatch origin prior to placement using the SNAPBASE command.

Step 1: Key in the SNAPBASE command and pick the desired hatch origin.
Step 2: Hatch as needed.

AUTODESK
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20 Non-Explodeable Blocks! Autodesk &“!

In 2006, you can prevent specific blocks from being exploded by users. If you are a CAD Manager,
you have probably been waiting for this one right?

Using Block Editor

Step 1: Select the block you need to protect

Step 2: <Right-Click> and select the Block Editor Block name RMNUM
Scale uniformly No
command =
Allow exploding No v
Step 3: Locate the Block Section and modify the Units Unitless
Allow Exploding setting to NO. Description
Hyperlink

Step 4: Select the Close Block Editor button.

If you want to prevent the user from having access to this same command, modify the system
variable BLOCKEDITLOCK.

BLOCKEDITLOCK controls access to the Block Editor and editing of dynamic block definitions.

0 — the block editor can be opened.
1 — the block editor cannot be opened.

=&

* BEDIT command not allowed. Block Editor is disabled.

=N B L
2 1 Auto-Exploded Blocks iEi [;l i = ﬂ.

If you use WBLOCK files for your standard details you can automatically explode them on insert
using the following command.

-INSERT *blockname

Insert Block Exploded

Step 1: Key in the following command to insert the detail “exploded”.

-INSERT *DETAIL_1.DWG

AUTODESK
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22 Rotate the Paper Model Only =i L= S = ﬂ.

Want to Rotate the model in PaperSpace but not in ModelSpace? For example, you are working on
a civil road project and you need to rotate the model so that it fits better on the paper sheet.

Heading

Step 1: Activate the PaperSpace viewport you want to rotate the model in.
Step 2: Key in UCS and choose the NEW option.

* 0,0,0
Step 3: If you don’t know the next options use the button to see ZAxis
what options are available. We want to choose the ZAxis z';‘?‘"tt
. . jec
option. Key in Z -
Step 4: Key in the angle you want to rotate the model in this View
. h . X
viewport. For this example we want to rotate the view 70 =
degrees. z

If you don’t know the angle you can also use the 3POINT option and define the angle
of rotation graphically.

\
23 New INPUT Rules Autodesk &"‘!

AutoCAD 2006 introduces some new coordinate input rules. If you are using the dynamic input,
and eventually you all will be, you can control the coordinate input using the following rules.

Relative Coordinates: 2,20 is relative to previous coordinate location
Absolute Coordinates: #2,20 is an absolute coordinate location in the current UCS
World Coordinates: *2,20 is a world coordinate location

Easier Relative Distances

I don’t know about you, but | have keyed in enough “@” symbols to last me a lifetime! How about
you? Here is another way to avoid the “@” symbol in AutoCAD 2006.

Step 1: Start the LINE command and key in 1,1.

Since this is the “first” input, it is interpreted as ABSOLUTE.
Step 2: Key in 2,2.

Since this is the “second” input, it is interpreted as RELATIVE to the first point.
Step 3: Key in #2,2.

Since this is the “second” input, it is interpreted as ABSOLUTE.

AUTODESK
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24 Easier CORNERSs &“!

When using the FILLET or CHAMFER commands you no longer have to set the radius to “0” to get
clean corners. Just use the new SHIFT key override to temporarily set the radius to “0”.

ZERO Radius — Just Once!

Step 1: Select the FILLET command and change the radius to “1”

Step 2: Fillet the lines with the 1” radius.

Step 3: Re-start the FILLET command and fillet the second set of lines with a “0” radius using
the SHIFT key override when picking the objects.

You didn’t have to reset the radius back to “0”!

25 o
Auto-Complete for AutoCAD Autodesk fasth |

AutoCAD 2006 now provides an “Auto-Complete” option for command key-ins. Use the TAB key to
look up commands matching your partial key-in.

Auto-Complete the CMD... Commands

Step 1: Key in CMD and hit the TAB key to look up what commands are available that start
with CMD. You should get the following options:
CMDACTIVE
CMDDIA
CMDECHO
CMDINPUTHISTORYMAX
CMDNAMES

The next “Secret” | want to discuss is the CMDINPUTHISTORYMAX setting.
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=

You can control the number of commands remembered in the command history list. The command
history can save commands for the entire drawing session or for the current command. You can

also turn off command history if that is your preference.

Accessing the command history list can be accomplished using the shortcut menu, or using the Up

and Down Arrows on the keyboard.

CMDINPUTHISTORYMAX is the number of command inputs to save. This can be set from 1 to

255. The default is 20.

Use the INPUTHISTORYMODE system variable to modify your
preferences for saving and accessing command history.
Default is 15, enabling the 1 + 2 + 4 + 8 = 15 options.

0 - No history of recent input is displayed

1 - History of recent input is displayed at the command line or
in a dynamic prompt tool tip with access through Up Arrow

and Down Arrow keys

2 - History of recent input for the current command is
displayed in the shortcut menu

Enter |
Cancel

Recent Input b 242504, 19868
Close
Undo 21.5125,19.0740

Snap Oyerrides r

o Pan

£ foom
B Quickealc

22.2753,20.8641

2000080, 20656
15.9504,21.4043

Recent Commands +  LINE

RECTANG

O5AVE
INPUTHISTORYMODE
OFFSET

COPY

Copy History

I ranspareny...
Options...

4 - History of recent input for all commands in the current session is displayed in the

shortcut menu

8 - Markers for recent input of point locations are displayed in the drawing
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2 7 Temporary ORTHO &“!

Everyone has been using F8 to toggle ORTHO ON and OFF for years. One of the newest
enhancements in AutoCAD 2006 is the introduction of “temporary overrides”. The one | think is
most useful is the override for ORTHO. We no longer have to turn ON ORTHO to use it.

POLAR and ORTHO Together

| like to have POLAR be my default drawing aid instead of ORTHO these days, but now | can have
both at my disposal.

Step 1: Start the LINE command using POLAR set to 45 degrees. If | need to force ORTHO for
some reason, | can by holding down the SHIFT key while drawing. Now | only have
access to “0” and “90” degrees — ORTHO.

When | stop holding down the SHIFT key I am back to using POLAR at 45 degrees.

\
28 Edit YOUR Scale List Autodesk &“!

I assume everyone uses the new scale list available for setting viewport scales since it is so much
easier than the old XP scale options. This list is now editable in AutoCAD 2006.

If you have some “obscure” viewport scales that you use on a regular basis, or you want to prevent
users from using scales that are “not standard” for your organization you should edit this list using
the new command SCALELISTEDIT.

ADD Viewport Scales

[Bl] Edit Scale List &3]
Step 1: Key in the command SCALELISTEDIT to add BBl
an additional scale to the viewport scale list . ‘a 4dd..
dialog. H
Step 2: Pick the ADD button to add the new scale. 15123
.
i 3
1 paper unit =1 drawing unit
QK ] [ Cancel ] [ Help ]

REMOVE Viewport Scales

Step 1: Key in the command SCALELISTEDIT to add an additional scale to the viewport scale
list dialog.

Step 2: Pick the DELETE button to remove scales from the list.
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29 The Power of PEDIT KEil E' L& & m'

Everyone using the PEDIT command but many of you don’t take advantage of some of its powerful
options. For example, have you ever tried to joint several lines using the PEDIT command only to
find that it fails due to “sloppy” drafting, by your co-workers of course!

Did you know that there is a “fuzz” factor you can apply to close those gaps in the lines? YES!
This option is only available through the MULTIPLE option, so try it out!

The FUZZ Factor

Step 1: Start the PEDIT command.

Step 2: Key in M for the MULITPLE option.

Step 3: Select all the objects you wish to join together and convert to polylines.
Step 4: Key in J for the JOIN option.

Step 5: Enter in the “fuzz distance” for the “sloppy” lines.

This distance should be slightly large than the “sloppy” error gaps or overlaps.

Step 6: Press ENTER to complete the command.

=N = A
30 Auto-Edit Text Options i C' L& = r‘.

If you need to auto-number some text in your file, there is a quick Express Tool to help you out.
So think of using this for notes, room numbers, part numbers, etc.

Auto-Number your Notes

Step 1: Select Express - Text - Automatic Text Numbering.

Step 2: Select your existing text objects.

Step 3: Choose your preferred sort order for the numbering sequence.
Step 4: Set your preferred Start number and Increment number.

Step 5: Choose where you want the number placed in the text objects:
e Overwrite

e Prefix
. GENERAL NOTE ONE 1 GENERAL NOTE ONE
e Suffix
e Find&replace GENERAL NOTE TWO 2 GENERALNOTE TWO
GENERAL NOTE THREE 3 GENERAL NOTE THREE
GENERAL NOTE FOUR 4 GENERALNOTE FOUR
GENERAL NOTE FIVE 5  GENERALNOTE FIVE
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I hope each of you will go home with some new tools in your arsenal for AutoCAD, no matter which
version of AutoCAD you are using!

If you have any questions, feel free to contact me here at the conference, or when you return

4 ]

home and have some time to recuperate! =

Thank you for your time

Hope you enjoyed the session!

Contact Information:

hus

ASSOCIATES

12005 Quail Drive
Bellevue, NE 68123-1175
www.aarhusassociates.com

Jeanne Aarhus
(402) 408-9696
jeanne@aarhusassociates.com
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